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Introduction 
TDD is a Windows based software program which assists with determining the optimal traffic 
signal timing parameters that would allow for the most efficient traffic progression along a route of 
multiple intersections. 
 
The name TDD is derived from the acronym Time Distance Diagram. The main function of TDD is 
the production of Time vs Distance diagrams for a set of coordinated intersections. 
 
The key to efficient movement of vehicle platoons through multiple intersections during the Green 
phases for a particular direction is the intersection Offset. Through the use of TDD the user can 
easily manipulate phase timings and intersection offsets for a particular intersection set and have 
the resulting Time Distance Diagram graphically displayed. 
 
TDD allows for easy addition of intersections to a project file and easy modification of intersection 
parameters. Comparison of alternative timing options for an intersection set can be performed with 
up to 10 different timing plans per project file. 
 
The input parameters and graphical output from the time distance diagram can be exported in .csv 
and .bmp format. 

Figure‐1   Example Diagram ‐ 5 Intersections sequenced in the North Bound Direction. 
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Installation 
 TDD is installed with a single setup file: “TDD 2015 setup.exe” which can be downloaded 
from https://www.traffictdd.com 

The default location for the application folder is C:\Program Files\TDD 2015 
During the installation process the user will have the choice of installing a Shortcut in the 

start menu, Desktop icon and a Quick launch icon. 
Once installed the application folder will contain the following files: 

1. “TDD 2015.exe”  
2. “TDD 2015 Manual.pdf “ 
3. “tdd.ini” (Configuration File) 
4. EULA 
5. “unins000.exe” (TDD Uninstall Program) 

System Requirements 
To use TDD 2015, your computer must have: 

1. Microsoft Windows 7 (32-bit or 64-bit), Windows Vista (32-bit or 64-bit) or Windows XP. 
2. Minimum monitor resolution of 1024 x 768. (1920x1080 recommended). 
3. Pentium processor 1.5 GHz or higher. 
4. 128 MB Ram. 
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Main	Form	
The Main form is shown in Figure-2  below with the main components labelled.  

FIGURE–2    Main Form. 
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Main Form Menus 
File 
New Menu: Creates a new project.  
Open Menu: Opens a saved project. TDD 
project files have the file extension “.tdd” 
Save:  Saves the current project file with 
existing file name. 
Save As: Saves the current project file 
with a new file name. 
Recent Files: Contains up to 10 most 
recently used files. 
 

 

 
Edit 
    From the Edit menu the user can select 
the Undo/Redo functions if enabled and 
Add or Delete intersection functions. 
 

 

 
Tools 
    The Tools menu provides access to the 
View Map Form and Options Form and the 
Set Sequence functions. 
 

 

 
 

Help 
    The Help menu provides access to the 
TDD User Manual in .pdf format. The User 
Manual will be copied to the users 
computer with the program files during the 
installation process.  
    This menu also contains a link to the 
TDD website: (https://traffictdd.com) and 
an about dialog box which provides 
information on the TDD version installed. 
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TD Diagram  

Projection	Lines	
The Show Frame controls what parameters are displayed on the TD Diagram. This frame consists 

of 3 projection line types for both the NB & SB directions. Each line type can be allocated a different 
colour, the default colours are shown in Figure-3 below. These colours can be changed in the Options 
Form – setting projection line colours. 

If the check boxes for these line types are checked then all of the projection line types will be 
displayed on the TD Diagram.  

Figure‐3    Show Frame – Projection Lines 

 
 
1. The NB Sequence parameter is the line drawn from the first intersection in a sequence 

through to the last intersection only if the condition that a vehicle would not be required to stop at any 
of the intersections. 

2. The NB Next and Through parameter is drawn from one intersection to the next NB 
intersection if a vehicle would arrive at the next intersection during the next green phase. 

3. The NB Next only parameter will simply be drawn from any intersection at the given speed 
regardless of any other intersections parameters. 

4. Clicking the “NB All” checkbox will turn all of the NB projection lines and “NB phase extents” 
parameters on or off. 

The same applies to the SB parameters as described above. 
 
Figure-4  over page provides an example of the above principles.  
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Figure‐4       TDD ‐ Projection Lines 

 
 

From Figure-4  we have 3 intersections, each with a 30 second NB phase, (Phase A).  
This intersection set is sequenced NB with the IntNo-2 lagging 16 seconds behind the travel 

time from IntNo-1 of 24 seconds. We can see the grey band (NB Next Only) starting from the time 
of 0s from IntNo-1 through to IntNo-2 for this 16 second period only.  

For the remaining 14 seconds of the green phase for IntNo-1 the blue band (NB Sequence) is 
displayed as this period passes through the green of all the intersections in this set. 

For the remaining 16 seconds of the green phase for IntNo-2 we see the green band (NB Next 
& Through) through to IntNo-3, it is not sequenced as it does not pick up any of the NB green 
phase period from IntNo-1. 
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Phase	Extents	
    With all projection lines turned off and the 
phase extents parameter turned on, the 
resulting diagram will appear as in Figure-5 with 
a green line indicating the start of the phase 
either NB or SB and a red line indicating the 
end of the phase. 
 

 
 

Figure‐5    TDD ‐ Phase Extents  
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Cycle	Extents,	Phase	Letter	&	Phase	
Start	Time.	
    With all the above parameters turned off the 
TD Diagram will be displayed as in Figure-6. 
 

 

Figure‐6    TDD ‐ Phase Extents Only 
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Phase	Band	
The phase bands represent intersection phases. In Figure - 7 below we have an 

intersection with 4 phases each with a different phase band colour to represent one of the 4 
possible sequence directions for that phase. Each of these phases has been allocated a 30 
second Green time, 4 second Yellow time and 2 second Red time.  

In this case:  PH-A = NB,  
PH-B = SB,  
PH-C = NB & SB,  
PH-D = NA. 

Figure – 7    Intersection phase bands. 

 
 

Related info; see: Setting phase band colours; Setting the phase sequence direction; 
Phase Options. 

 

Adding Intersections 

Method 1 
Click the “Add Intersection” button on the Intersection Table Toolbar. 

 
 

Method 2 
 Shortcut key: F6. 

Method 3 
Edit Menu > Delete Intersection. 

 
Figure-3 shows an example of the TD Diagram after 3 intersections have been added with 

the default values. 
As the sequence setting is set to “North Bound” (NB) and the “Auto Sequence” check box 

set to true each intersection is allocated with an offset value equal to the time taken to travel from 
the previous intersection with the first intersections offset value set to 0. 

If  the “South Bound” (SB) option in the Sequence frame is selected and then the “Set” 
button is clicked, the sequence will be set in the SB direction as shown in Figure - 4.  

If the Auto Sequence option is switched off then each new intersection offset will be 0.  
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   Figure‐3  3 Intersections sequenced NB. 

 
 

Figure‐8  TD Diagram – 3 Intersections sequenced SB. 
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Intersection Default Values 
The default values for the intersection, phase parameters and diagram display settings can 

be modified in the Options form – Intersection Options. 
Any intersection added to the project will be assigned these default values. 

Deleting Intersections. 

 

 
 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 

Method 1 
 Click the “Delete Intersection” button on the Intersection Table Toolbar. 

 

Method 2 
Shortcut key: Shift+Del. 

 

Method 3 
Edit Menu > Delete Intersection. 
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Modifying Intersection Parameters 
The intersection parameters are modified in the Intersections Table by double clicking on 

the cell of the parameter you want to change. After modifying the cell contents, new values will 
only be accepted by pressing the Enter key. 

Offset	Adjustment	

Method 1 
 Select the intersection in the Intersection Table Toolbar. 
 Double click on the offset cell & type in the new value and press the Enter key. 

    The TD Diagram and the Offset scroll value will then be updated with the new offset value. 
 

 
 

Method 2 
 Click on the Intersection offset scroll bars left or right arrow or inside the scroll bar left or 

right of the current value. 
    The offset value will be adjusted up or down by the value in the intersection offset small change 
and large change settings.   See Options Form/Intersection. 

 

Intersection	Description,	Distance	and	Speed	
These parameters are modified in the same way as described in Method 1 for offset 

adjustment above. 

Phase	Times	
The phase time can be changed for any phase in the intersection table the value displayed 

will be either just the green period for that phase or the total phase time,  (green + yellow + red).  
Different Yellow & Red times can be applied to individual intersections.   
After changing these values in the Options form the new values will be applied to any new 

intersections added to the project.  
 
Related info; see: Phase Options. 
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Phase sequence direction 
 Each phase for an intersection can be allocated one of the 4 sequence direction types as 
detailed in the table below. 

 
Sequence 

Direction Type 
Description Default Colour 

NB Phase allows NB movements only. 
 

SB Phase allows SB movements only.  
 

NB & SB Phase allows both NB and SB 
movements. 

 

NA – Not 
sequenced  

For phases that do not allow either North 
or SB movements. 

 

 
 The default setting for the sequence direction of each new intersection added is:  

1st phase = NB & SB,  
2nd phase = NB,  
3rd phase = SB, 
4th phase = NA. 
 

Related info; see: Setting phase band colours; Phase Options. 
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Setting	the	phase	sequence	direction	
 

Method 1     Right click on the phase in the intersections table. A popup menu will appear 
with the following options and allow for setting that phase to one of the 4 sequence 
directions types: 

 
 

Method 2 
 

    Right click on the phase in the td diagram to display the same popup menu as 
above. 

 
 

 

Adding Plans 
 A project file can contain up to 10 plans. Each plan can contain different intersections and 
parameters. Adding a new plan will reset the TD Diagram and intersection table.  
 To add a plan click the “Add Plan” button on the Intersection Intersection Table Toolbar. 
 

 
Once a project has multiple plans, different plans can be selected using the plan selection 

bar. 
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Cloning Plans 
 Cloning a plan will copy the currently selected plan data into a new plan. 
 

Click the “Clone Plan” button on the Intersection Table Toolbar. 

 
 

Deleting Plans 
Click the “Clone Plan” button on the Intersection Table Toolbar. 

 

Changing the Plan Name 
 By default each new plan will be given the name “Plan - #”; where # = the total number of 
plans in the project. This plan name will be displayed on the TD Diagram title and in the plan 
selection bar title. 
  

 
  

The plan name can be changed by double clicking on the TD Diagram title. This will 
activate a text box to allow modification of the plan name. 
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The TD Diagram title font type and colour can be changed by right clicking on the title. This will 
then display the following popup menu. The font type & colour can then be selected. 
 

 
 

Adding or Removing Phases 
    Click the “Phase” button on the Intersection Table Toolbar. 

 
    Upon clicking the Phase button the following dialog box will appear.  
 

 
    Input parameters:  

Type = numeric only. 
Minimum = 2. 
Maximum = 6. 

    Phases added to the intersection will have the sequence direction code – NA, which means it 
won’t be sequenced either NB or SB. (See - Setting the phase sequence direction.) 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 



https://traffictdd.com													TDD	2015																		User	Manual 

     Published: 30/3/2015 

 18 

Contents 

Undo & Redo Functions 
The Undo & Redo functions are enabled for events performed from the toolbar or within the 

table only and are reset if a plan is added, cloned or deleted. 
Program events that are added to the Undo/Redo stacks include: 

1. Add or Delete Intersection. 
2. Modification of any table cell. 

Method 1 
    Click the “Undo or Redo” button on the Intersection Table Toolbar. 

 

Method 2 
    Shortcut keys:    Undo: Ctrl + Z 
                    Redo: Ctrl + Y 
 

Exporting the Intersection table 
Click on the “Save Table” button in the Intersection Table Toolbar. 

 
A “Save As” dialog will appear with the default file of: App.Path & "\Project Files\". The default file 
name is the Plan Name of the current plan selected. 

 
 

When opened in Excel this output file will appear as shown below. 

 
 

Using the tdd_csv macro this file can be formatted with the click of a button to display the 
data as shown below. A copy of this macro is provided in Appendix-4. 

Figure‐9  Formatted table output. 
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Copying & Exporting the TD Diagram 
Clicking the Copy button in the Image frame will copy the TD Diagram to the Windows 

clipboard. The image can then be pasted into any other applicable application. 
The Export button opens a Save As dialog box where the image can be saved as a .bmp 

file. This image will be stamped with the file name and current date. 
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Map	View	Form		
The Map View form can be accessed through: Tools -> Map View.  
The location details required for input are either the intersection address or the latitude and 
longitude of the location to be displayed. The map will then be updated with the intersections 
location as shown below. 

Figure ‐ 10 – Map View Form. 
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Options	Form		

Intersection Options 
Table - 1 below lists the default values that may be changed in the Intersection options Tab. 

These values are used for any new intersection added to the project. 
This Tab is accessed by clicking: Tools\Options\Intersection or shortcut key: Ctrl & T. 
These values can be restored to the default values by clicking the “Restore Defaults” button. 

Table ‐ 1 ‐ Intersection default values. 

Parameter Description Units 
Default 
Value 

Data 
Type 

Min 
Value 

Max 
Value 

Distance to 
next 

Distance to the next 
intersection to the North 

Meter 400 Integer 50 5000 

Speed North 
Travel speed to the next 
intersection to the North 

Km/h 60 Integer 1 110 

Speed South 
Travel speed to the next 
intersection to the South 

Km/h 60 Integer 1 110 

Offset scroll – 
small change 

Change value of scroll bar 
upon Intersection scroll bar 

arrow click 
NA 1 Integer 1 5 

Offset scroll – 
large change 

Change value of scroll bar 
upon Intersection scroll bar 

inside click 
NA 5 Integer 2 10 

 

Figure ‐ 11 ‐ Intersection Options Tab. 
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Diagram Options 

Setting	projection	line	colours	&	Setting	phase	band	colours	
The Diagram options tab allows for setting of the projection line and phase band colours.  
By clicking on the colour next to the projection line description the color dialog box will 

appear. The chosen colour will then be used for that projection line.  
Related info; see: Projection Lines; Phase Band. 
 

Figure ‐ 12 ‐ Diagram Options Tab. 
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Phase Options 

Phase	Time	Displayed	
The phase time displayed in the intersection table can be toggled between either total 

phase time (Default) or phase green time only.  

Figure ‐ 13 ‐ Phase Options Tab. 

 
 

The figures below show the total phase time of 36 seconds displayed in the intersection 
table along with the corresponding TD Diagram showing the phase split of GT=30s, YT = 4s, RT = 
2s. 

With this option changed to “Display Phase Green Time” all phase times in the intersection 
table will change to 30s, the TD Diagram will remain unchanged. 

 

      
 

 
Related info; see: Phase Band. 

 

Phase	Time	Values	
The next part of the phase frame allows you to change the GT, YT, & RT and the number of 
phases for any new intersection added. 
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Help	
This manual will be saved in the program directory as a .pdf & .mht file as a part of the TDD 
installation process. 
 
This manual can also be downloaded from this website: 
 
http://traffictdd.com 
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APPENDICIES	

Appendix-1 

Shortcut	Keys	

Action Shortcut 

File Menu  
New File Ctrl + N 
Open File Ctrl + 0 
Save File Ctrl + S 
Exit Ctrl + Q 

Edit Menu  
Undo Ctrl + Z 
Redo Ctrl + Y 
Add Intersection F6 
Delete Intersection Shift+Del 

Tools Menu  
Options Alt + O 
Set Sequence – NB Shift+F7 
Set Sequence – SB Shift+F6 

Help Menu  
Manual F7 
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Appendix-2 
 

List	of	figures	
 
Figure-1 Example Diagram - 5 Intersections sequenced in the North Bound Direction. 

Figure-2 Main Form. 

Figure-3 Show Frame – Projection Lines. 

Figure-4 TDD - Projection Lines. 

Figure-5 TDD - Phase Extents. 

Figure-6 TDD - Phase Extents Only. 

Figure-7 Intersection phase bands. 

Figure-8 TD Diagram – 3 Intersections South Bound. 

Figure-9 Formatted table output. 

Figure-10 Map View Form. 

Figure-11 Intersection Options Tab. 

Figure-12 Diagram Options Tab. 

Figure-13  Phase Options Tab. 
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Appendix-3 

End	User	License	Agreement	
 

The End User acknowledges and agrees that by clicking on the “I ACCEPT” button displayed 
during the installation process of TDD 2015 when this EULA is displayed, the End User is deemed 
to have accepted the terms and conditions of this EULA and becomes the licensee of the software.  

 
The Licensee is hereby licensed to use the Trial version of the product for the Trial period 

specified by the product.  You may make as many copies of the Trial version of this software and 
documentation as you wish and redistribute exact copies to anyone via any means, as long as 
they are complete with absolutely no additions or removals from the original product. The following 
terms are complied with. 
 

1. The Licensee is only granted a license for the machine-readable, object code portion of the 
Software. The Licensee  must not modify, enhance, reverse engineer, disassemble,  or 
otherwise alter the Software from its current state. 

 
2. The Licensee  will not have any proprietary rights of the Software. The Licensee  

acknowledge and agree that the Producer retains all copyrights and other proprietary rights 
of the Software. 

 
3. The Software is provided "as-is," without any express or  implied warranty. Without even 

the implied warranty of merchantability and fitness for a particular purpose. In no event 
shall the Producer be held liable for any, direct or indirect, damages arising from the use of 
the Software. 

 
4. The Licensee acknowledges that the Pre-release Software does not represent the final 

product from the Producer, and may contain bugs, errors, and other problems that could 
cause system or other failures or data loss.  

 
5. All redistributions of the Software's files must be in their original, unmodified form. 

Distributions of modified versions of the files is not permitted without written permission of 
the Producer. 

 
6. All redistributions of the Software's files must retain all copyright notices and web site 

addresses that are currently in place, and must include this list of conditions without 
modification. 
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7. None of the Software's files may be redistributed for profit or as part of another Software 
package without express written permission of the Producer. 

 
8. Use of the Software within the scope of this license is free of charge  and no royalty or 

licensing fees shall be payable by The Licensee. Use beyond the scope of this license shall 
constitute copyright infringement. 

 
9. The Producer is not obligated by this EULA to provide Licensee with any technical 

support services relating to the Software. 
 

10. The Producer reserves his rights to modify this agreement in the future. 
 

11. If The Licensee  do not agree to all of the above terms, The Licensee  are not permitted to 
use the Software in any way, and all copies of it must be deleted from The Licensee’s 
system(s). 

 
The Licensee  are specifically prohibited from altering any part of this product, charging for any 
copies, however made; and from distributing the software, documentation and/or portions of either 
the software or documentation with other products (commercial or otherwise) without the 
expressed written consent from the Producer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


